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Welcome to GoldMine
The following document includes important information, including corrections to the GoldMine documentation
and supplemental information not available when the documentation was printed. Please keep this document in
a safe place and use it in conjunction with the GoldMine documentation.
1. Please read the corresponding versions of the Compatibility Matrix and Installation Guides for GoldMine
Premium and GoldMine Connect before installation. You must install prerequisites and verify environment
compatibility before installing GoldMine. Documentation is provided in the GoldMine download from our
Self-Service portal and is available in our Knowledgebase. See
https://community.ivanti.com/community/all-products/goldmine to access the GoldMine Community and
knowledge articles about GoldMine. For information about new features of GoldMine, please see the Release
Notes. After installation, Release Notes are available in GoldMine Premium Edition via Help >> Release
Notes.
2.

If you are switching from GoldMine Plus for Outlook to GoldMine Link for Outlook or vice versa we recommend
uninstalling GoldMine Premium and reinstalling choosing desired Outlook option during reinstall. Please select to
connect to existing database pointing to the shared GoldMine data folder on the server during the reinstall.

3.

In GoldMine 2018.2 version we added as pre-requisites SQL Native Client 11 for Premium Edition and URL
Rewriter for GoldMine Connect. When the installation process starts, the first step is to perform a check
to make sure these pre-requisites are installed on the system. In the case they are not, the installer will
download them from the Internet and install them. Due to this it is necessary to have internet access
while performing the installation, otherwise the installation will fail when the pre-requisites are not
met.

4.

TRUSTSELFSIGNEDCERTIFICATES setting that is used for database encryption in the dbalias.ini is a general
system setting. In case of environments with multiple contact sets defined on different database servers
please make sure that on each database server there is the same certificate configuration (with or
without certificate defined), otherwise there will be problems in connecting to the database.

5.

The read-only user needed for the SQL Query function is defined per DB Alias. In environments where
multiple DB Aliases exist, please make sure you have a read only user created for each DB alias.

6.

In GoldMine 2018.2 version we added password complexity rules and password validation on login. In
previous versions, passwords were saved in the database using upper case letters. Existing users that do
not change their password after the upgrade must enter their password using upper case letters at login
in GoldMine Premium Edition or GoldMine Connect.

7.

If you exchange iCalendar (iCAL) messages with Outlook users, please note that Outlook handles iCAL
messages best when configured to use Internet Mode and POP3 account(s).
a. Using Workgroup Mode or configuring Outlook to send/receive messages from a Microsoft Exchange
Server only, may result in lost Activity details on replies sent by the Outlook recipient or
difficulties in the handling of replies to activities sent by Outlook users.
b. IMPORTANT: Differences in the handling of recurring activities may present problems when using
iCAL messages. If exchanging recurring activities with an Outlook client using iCAL messages, do
not make changes to the activities once they have been accepted.

8.

Synchronizing very large databases (approximately 20GB or higher) may cause GoldMine to run out of
memory, if there is insufficient RAM installed.

9.

In the current release of GoldMine Premium Edition, the Service module works only with a single contact
database (i.e., the contact set alias must be identical to the alias for the base GoldMine tables).

10. The Merge/Purge Wizard function "Prompt me before merging records" option may cause performance to
slow and an eventual crash when the process identifies and presents many duplicates. To avoid this, use a
filter or group to limit the number of records being processed.

11. If you use GoldMine's e-mail templates, please note that you cannot enable the Wrap Lines option to
toggle it on/off.
12. When using an e-mail template created outside of GoldMine, replies to e-mail messages may have
unexpected or inconsistent fonts. This problem can occur if the fonts in the template are based on a
style sheet, using the HTML <STYLE> tag. To ensure that your messages are formatted as expected,
please ensure that each paragraph of text within your e-mail template includes an inline font definition
(using a <FONT> tag after the <P> tag in the HTML template, for example).
13. The Output To > Word feature currently does not work properly if Microsoft Excel is open. Please close
Excel before using this feature.
14. When running a mail merge to a filter or group using GoldMine Plus for Microsoft, please do not switch
between documents using the Word Mail Merge toolbar while GoldMine is still merging documents.
Switching between documents may prevent GoldMine from creating history records for one or more of the
documents that you viewed.
15. Microsoft Word Trust Center Settings may prevent you from opening or merging a GoldMine document
template. To resolve this, add the GoldMine document template folder (usually
C:\ProgramData\GoldMine\Template or C:\Program Files\GoldMine\Template) and subfolders as trusted
locations in Word.
16. If you open a document in Microsoft Word while a different Word template is being previewed in the
Document Management Center, the File menu in Word may be disabled. You can use one of several
methods to resolve this.
a.
b.
c.
d.

In Document Management Center uncheck option to preview templates.
Close the Document Management Center in GoldMine.
Disable the preview of Word templates in GoldMine, via Tools > Configure > System Settings >
Preview.
Launch Word using the "/w" switch to start a new instance of Word. Please read the following
article for detailed instructions: http://support.microsoft.com/kb/210565.

17. The automatic login prompt for GoldMine Plus for Microsoft Word may interfere with the display of Word
documents within Internet Explorer. To prevent this issue from occurring, launch Microsoft Word and if a
GoldMine login screen appears, check the box labeled "Don't show this dialog again".
18. If you have Microsoft Excel running with an Excel file open, viewing another Excel file within a preview
pane in GoldMine may prevent Excel from operating properly. If this occurs, change the view in GoldMine
so an Excel file is no longer being previewed.
19. If an Excel file is displayed within a Preview Pane in GoldMine Premium, an attempt to merge an Excel
document template (.xlt or .xltx file) may fail with an error. To prevent this problem, please change the
view in GoldMine so an Excel file is not being previewed before merging the template.
20. Macros executed within GoldMine Premium may fail if they rely on keystroke combinations that are
duplicated between items on the toolbar and other screens. To correct this problem, remove toolbar
items that have the same keystrokes as the actions used by the macro.
21. The Sync Contact setting in GoldMine Premium may result in slow performance when deleting activities
from the activity list or using drag-and-drop features on the calendar. If this problem occurs, please
turn off the Sync Contact setting as follows: Right-click on the calendar, select Options, and make sure
"Sync Contact" is unchecked. Right-click on the activity list, select Options, View, and make sure "Sync
Contact" is unchecked.
22. If you schedule an all-day event and send a meeting request to a contact, the recipient's mail server
may translate the request into a timed activity, using the time zone of the server. If this occurs and the
recipient's system is in a different time zone from the server, the times viewed by the end user will be
offset by the time zone difference.
23. When clicking a hyperlink in GoldMine Plus for Microsoft Outlook to update a recurring activity that was
previously added to GoldMine, only a single occurrence of the activity may be updated. To update the
entire series, synchronize GoldMine with Outlook.

24. If attendees are added to an existing activity that was previously scheduled in Outlook and added to
GoldMine, the attendee list will not be transferred until GoldMine is synchronized with Outlook.
25. On some operating systems, including Microsoft Small Business Server 2011, Outlook synchronization
requires GoldMine Plus for Microsoft Outlook or GoldMine Link for Microsoft Outlook to be included when
installing GoldMine Premium Edition.
26. If a one-time activity is created in GoldMine and synchronized to Outlook and then modified in Outlook
to become a recurring activity, only the first instance of the recurring activity will appear in GoldMine
after synchronization.
27. The "Page Me" functionality that existed in some previous versions of GoldMine was replaced by
Messaging features in GoldMine Connect Edition. To use the "Page Me" feature without installing
GoldMine Connect Edition, add the following lines to your user settings file (<username>.ini):
[GoldPager]
PagerEmail=1234567890@smsgateway_for_carrier
Replace the email address shown above as appropriate for your mobile phone service.
For assistance in determining the e‐mail address, refer to https://community.ivanti.com/docs/DOC57592.
28. For security, users must have a password assigned in GoldMine Premium to successfully log into GoldMine
Web. If a user without an assigned password in Premium attempts to log into GoldMine Web, the user will
be advised "The username or password you entered did not match our records".
29. If you use multiple contact sets in GoldMine Premium Edition, the contact set opened for a user in
GoldMine Web is the same one most recently opened by the user in GoldMine Premium. It is not possible
to change contact sets in GoldMine Web ‐ the user must log into GoldMine Premium, open the desired
contact set, and then log back into GoldMine Web. Please note the following limitations in GoldMine
Web related to managing activities that are linked to a contact that is not in the active contact set.
a.
b.

SMS messages will not include contact-specific data if the activity is linked to a contact that is not in
the active contact set.
Activities linked to a contact that is not in the currently open contact set will become unlinked if
completed in GoldMine Web.

30. In GoldMine Web, custom labels for primary fields and Rule Based selection for custom screens are not
respected when selecting "dBASE expression result-based" and using an expression other than trim(key1)
for the Record Type Rule.
31. In order to successfully view, update, or create data in GoldMine Web, it is necessary to run an IISRESET
when the GoldMine database is rebuilt to add custom fields or when a lookup.ini file is added or updated.
32. A maximum of the previous 20 days of emails can be retrieved into the GoldMine database when logged into
GoldMine Web when the user's email settings are configured for IMAP (recommended). To retrieve Inbox
emails for more than 20 days, the user can log into GoldMine Premium. It is not possible to retrieve emails
from the specified IMAP Sent mailbox in GoldMine Premium.
33. When Replying to or Forwarding emails from GoldMine Web, a limited amount of the original message is
available in the Reply or Forward. This is due to limitations with some MailTo clients.
34. Notes in GoldMine Web are in plain text. When a note with formatted text is edited in GoldMine Web, the
formatting in Premium is removed.
35. If a field is configured as "Required Data Entry" in GoldMine Premium, there is no option to override this
feature when a user edits a record in GoldMine Web.
36. If the "Attach this process to all new contact records" option has been set for an automated process in
GoldMine Premium, the process must be executed within GoldMine Premium after creating a new record in
GoldMine Web.
37. Alarms sent as SMS messages are delivered when the system time on the server machine matches the time
set for the alarm.

38. The City and State fields for a contact record are not automatically filled based on the entry of a ZIP code in
GoldMine Web.
39. GoldMine Connect requires cookies to be enabled. If cookies are disabled or the Private Browsing option is
used, you will not be able to log in and use GoldMine Web.
40. An undocked user cannot login into GoldMine Web while already logged in to GoldMine Premium on a
network and connected to the application server used by GoldMine Web. The login will fail with a message
"All GoldMine licenses are already in use."
41. In GoldMine Web, prices are not automatically populated when selecting a product while creating a
forecasted sale, even if the lookup list for the Product fields has been configured with a price.
42. dBASE expression fields are not displayed for contact records in GoldMine Web.
43. dBASE expressions are not available for selection in lookup lists in GoldMine Web.
44. The use of alphabetic characters in the Time field to schedule a prioritized activity is not supported in
GoldMine Web.
45. If you create a forecasted sale in GoldMine Premium and relate it to an Opportunity, editing the sale in
GoldMine Web will not update the close date or value of the corresponding Opportunity.
46. Only the E-mail Rule actions "Move to Inbox", "File", and "File To" are respected when emails are
retrieved into the GoldMine database while logged into GoldMine Web.
47. To access Linked Documents from GoldMine Web, the document pointer must not be a mapped
drive; instead use a UNC path. Existing mapped drive path references can be updated using the
Tools > Data Management > Move Linked Docs and Attachments feature in GoldMine Premium.
48. License Limits and Definitions
a.

b.
c.

GoldMine Premium Edition is licensed per Concurrent or Named User: A Concurrent User is a
license that can be used by any Authorized User, but only by one at any given time. A Named User is
a license that can be used only by a specific Authorized (i.e., Named) User. Each Named User created
for use in GoldMine subtracts one Concurrent User license. A remote user accessing the Licensed
Software via a network connection to a centralized GoldMine installation is considered to be utilizing
one concurrent user license. A remote user or site accessing the Licensed Software in an undocked
scenario is considered to be utilizing one named user license.
You agree not to copy the Licensed Software except for backup and disaster recovery purposes, or
as described in the accompanying Documentation.
Should You exceed Your licensed number of Users, then You agree to pay the full list price for the
excess Users in accordance with the IVANTI then current price list, as well as the full Maintenance
and Support Fees related to these additional products.

Capitalized terms not defined herein shall have the meanings set forth in the applicable End-User License
Agreement.
These definitions are as of May 18, 2015.

49. Licenses
iGoldMine 2015.1 and up
Any versions of iGoldMine from iGoldMine 2015.1 will require a new license. This should be requested in
advance of doing an upgrade as it can take up to 24 hours (1 business day) to receive a new license. To get
your new license, please go to the website http://www.graphon.com/customer-support and submit your
request.
GoldMine Premium Edition 2014.2 and up
If upgrading from a version older than GoldMine Premium Edition 2014.2, you will need a new license. If you
do not have a 2014.2 or newer license, please see https://community.ivanti.com/docs/DOC-67070 before

installing or attempting an upgrade.
50. Third Party Components
GoldMine Premium Edition may include the following and other components: The
Sentry Spelling-Checker Engine Copyright © 1999 Wintertree Software Inc.
Apache Components. Copyright © 2000. The Apache Software Foundation. All rights reserved. GMPE includes
software developed by the Apache Software Foundation. Apache Software is subject to the conditions and
disclaimers listed in Apache License v.2.0 found at http://www.apache.org/. The Software is distributed on
an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
OpenSSL. Copyright © 1998-2008 The OpenSSL Project. All rights reserved. GMPE includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). The names
"OpenSSL Toolkit", and "OpenSSL Project" must not be used to endorse or promote products derived from
this software without prior written permission. For written permission, please contact opensslcore@openssl.org. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL"
appear in den names without prior written permission of the OpenSSL project.
If you would like more information about third party licenses, please contact your GoldMine sales
representative.
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